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ABSTRACT

There are many problems in metering and
billing processes like the going of meter
reader to each meter to manually take the
meter reading, the probability of the non-
existence of the customers at their houses
during that time, the lack of integrity and
credibility of some of the meter readers, the
safety (especially in Irag) and the outback
areas represent a huge drawback cannot be
neglected. In other hand, the in service
classical energy meter type (generally
induction type) suffers from well-known
measuring errors. The above problems
result in a two significant points, waste of
much money due to the large number of
employees (meter readers) and the weakness
in electricity management which results in
lack in electric power. The presented paper
provides an excellent solution (Automatic
electrical energy billing) to the problems
mentioned above where the system has been
designed based on the use of energy smart
meter to read electrical energy consumed to
get an accurate reading. Then the energy
meter reading is sent to the control center in
the electricity department based on
GSM/SMS technology. The system in the
electricity department receives readings and
makes processing operations on them and
extracts the bill that must be paid by the
customer. The system also sends a message
to the own customer mobile phone which
contains the current bill, due bill, and total
bill every two months (according to Iraqi
regulations) have to be paid. In addition the

system has the ability to print out a hard
copy of the customer bill. Finally the
proposed system has the ability of automatic
power outage if the customer refrains or
delays for certain time in paying the bills by
means of an SMS massage. The designed
system is implemented practically and
applied to three customers in coordination
and cooperation with the engineers in the
General  Directorate  of  Electricity
Distribution for Middle Euphrates and it has
been proven by the results obtained and
presented in this paper, the system has high
accuracy and reliability. Also the engineers
in Babylon province electricity department
praised the results obtained and the
feasibility and economic interest of the
presented system.

Keywords: Power Supply, Microcontroller,

INTRODUCTION TO EMBEDDED
SYSTEMS

2.1Application Areas

Nearly 99 per cent of the processors
manufactured end up in embedded systems.
The embedded system market is one of the
highest growth areas as these systems are
used in very market segment- consumer
electronics, office automation, industrial
automation,  biomedical  engineering,
wireless communication, data
communication, telecommunications,
transportation, military and so on.

2.1.1 Consumer appliances At home we
use a number of embedded systems which
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include digital camera, digital diary, DVD
player, electronic toys, microwave oven,
remote controls for TV and air-conditioner,
VCO player, video game consoles, video
recorders etc. Today’s high-tech car has
about 20 embedded systems for
transmission control, engine spark control,
air-conditioning, navigation etc. Even
wristwatches are now becoming
embedded systems. The palmtops are
powerful embedded systems using which
we can carry out many general-purpose
tasks such as playing games and word
processing.

2.1.2 Office automation: The office
automation products using em embedded
systems are copying machine, fax machine,
key telephone, modem, printer, scanner etc.

2.1.3 Industrial automation: Today a lot
of industries use embedded systems for
process control. These include
pharmaceutical, cement, sugar, oil
exploration, nuclear energy, electricity
generation and  transmission.  The
embedded systems for industrial use are
designed to carry out specific tasks such as
monitoring the temperature, pressure,
humidity, voltage, current etc., and then
take appropriate action based on the
monitored levels to control other devices or
to send information to a centralized
monitoring station. In hazardous industrial
environment, where human presence has to
be avoided, robots are used, which are
programmed to do specific jobs. The robots
are now becoming very powerful and carry
out many interesting and complicated tasks
such as hardware assembly.

2.1.4 Medical electronics: Almost every
medical equipment in the hospital is an
embedded system. These equipments
include diagnostic aids such as ECG, EEG,
blood pressure measuring devices, X-ray
scanners; equipment used in blood
analysis, radiation, colonscopy, endoscopy
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etc. Developments in medical electronics
have paved way for more accurate
diagnosis of diseases.

2.1.5 Computer networking: Computer
networking products such as bridges,
routers, Integrated Services Digital
Networks (ISDN), Asynchronous Transfer
Mode (ATM), X.25 and frame relay
switches are embedded systems which
implement the necessary data
communication protocols. For example, a
router interconnects two networks. The two
networks may be running different protocol
stacks. The router’s function is to obtain
the data packets from incoming pores,
analyze the packets and send them towards
the destination after doing necessary
protocol conversion. Most networking
equipments, other than the end systems
(desktop computers) we use to access the
networks, are embedded systems

2.1.6 Telecommunications: In the field of
telecommunications, the embedded
systems can be categorized as subscriber
terminals and network equipment. The
subscriber  terminals such as key
telephones, ISDN  phones, terminal
adapters, web cameras are embedded
systems. The network equipment includes
multiplexers, multiple access systems,
Packet Assemblers Dissemblers (PADs),
satellite modems etc. IP phone, IP
gateway, IP gatekeeper etc. are the latest
embedded systems that provide very low-
cost voice communication over the
Internet.

2.1.7 Wireless technologies: Advances in
mobile communications are paving way for
many interesting applications  using
embedded systems. The mobile phone is
one of the marvels of the last decade of the
20th century. It is a very powerful
embedded system that provides voice
communication while we are on the move.
The Personal Digital Assistants and the
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palmtops can now be used to access
multimedia services over the Internet.
Mobile communication infrastructure such
as base station controllers, mobile
switching centers are also powerful
embedded systems.

2.1.8  Insemination:  Testing and
measurement are the  fundamental
requirements in all scientific and

engineering activities. The measuring
equipment we use in laboratories to
measure parameters such as weight,
temperature, pressure, humidity, voltage,
current etc. are all embedded systems. Test
equipment such as oscilloscope, spectrum
analyzer, logic analyzer, protocol analyzer,
radio communication test set etc. are
embedded systems built around powerful
processors. Thank to miniaturization, the
test and measuring equipment are now
becoming portable facilitating easy testing
and measurement in the field by field-
personnel.

2.1.9 Security: Security of persons and
information has always been a major issue.
We need to protect our homes and offices;
and also the information we transmit and
store. Developing embedded systems for
security applications is one of the most
lucrative businesses nowadays. Security
devices at homes, offices, airports etc. for
authentication and  verification are
embedded systems. Encryption devices are
nearly 99 per cent of the processors that are
manufactured end up in~ embedded
systems.  Embedded  systems  find
applications in every industrial segment-

consumer  electronics,  transportation,
avionics, biomedical engineering,
manufacturing, process control and

industrial automation, data communication,
telecommunication, defense, security etc.
Used to encrypt the data/voice being
transmitted on communication links such
as telephone lines. Biometric systems using
fingerprint and face recognition are now
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being extensively used for  user
authentication in banking applications as
well as for access control in high security
buildings.

2.1.10 Finance: Financial dealing through
cash and cheques are now slowly paving
way for transactions using smart cards and
ATM (Automatic Teller Machine, also
expanded as Any Time Money) machines.
Smart card, of the size of a credit card, has
a small micro-controller and memory; and
it interacts with the smart card reader!
ATM machine and acts as an electronic
wallet. Smart card technology has the
capability of ushering in a cashless society.
Well, the list goes on. It is no exaggeration
to say that eyes wherever we go, we can
see, or at least feel, the work of an
embedded system.

Il. LITERATURE SURVEY

A new concept of energy meter will be
discussed, where maximum demand of
energy of a consumer will be indicated in
the meter used by the consumer. After
exceeding the maximum demand, the meter
and hence the connection  will
automatically be disconnected by an
embedded system inserted in the meter
itself [1] . GSM MODULE SIM 300 is
used to produce communication between
load circuit and utility side. We actually
have used max232 along with DB9
connector to interface it [2] . The system
consists of the electricity meter which
measures the electricity bill and informs
the consumer about the number of units
consumed and associated costs with it. The
microcontroller coordinates the whole
system with the help of its different
components connected to it [4] .
HARDWARE IMPLEMENTATION OF

THE PROJECT

This chapter briefly explains about the
Hardware Implementation of the project. It
discusses the design and working of the
design with the help of block diagram and
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circuit diagram and explanation of circuit
diagram in detail. It explains the features,
timer programming, serial communication,
interrupts of atmega328 microcontroller. It
also explains the various modules used in
this project.
3.1 Project Design
The implementation of the project design
can be divided in two parts.

- Hardware implementation

- Firmware implementation
Hardware implementation deals in drawing
the schematic on the plane paper according
to the application, testing the schematic
design over the breadboard using the
various IC’s to find if the design meets the
objective, carrying out the PCB layout of
the schematic tested on breadboard, finally
preparing the board and testing the designed
hardware.
The project design and principle are
explained in this chapter using the block
diagram and circuit diagram. The block
diagram discusses about the required
components of the design and working
condition is explained using circuit diagram
and system wiring diagram.
INTRODUCTION TO
MICROCONTROLLER
Based on the Processor side Embedded
Systems is mainly divided into 3 types
1. Micro Processor : - are for general
purpose eg: our personal computer
2. Micro Controller:- are for specific
applications, because of cheaper cost we
will go for these
3. DSP ( Digital Signal Processor ):- are
for high and sensitive application purpose
MICROCONTROLLER VERSUS
MICROPROCESSOR
A system designer using a general-purpose
microprocessor such as the Pentium or the
68040 must add RAM, ROM, 1I/O ports, and
timers externally to make them functional.
Although the addition of external RAM,
ROM, and 1/O ports makes these systems
bulkier and much more expensive, they
have the advantage of versatility such that
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the designer can decide on the amount of
RAM, ROM and I/0O ports needed to fit the
task at hand.

A Microcontroller has a CPU (a
microprocessor) in addition to a fixed
amount of RAM, ROM, 1/O ports, and a
timer all on a single chip. In other words,
the processor, the RAM, ROM, 1/O ports
and the timer are all embedded together on
one chip; therefore, the designer cannot add
any external memory, 1/0O ports, or timer to
it. The fixed amount of on-chip ROM,
RAM, and number of /O ports in
Microcontrollers makes them ideal for many
applications in which cost and space are
critical.

Microprocessor vs, Mevocantrollr

Microprocesor Mierocontroller
(U 5 tand done RAM, RAM. 10, | CPURAMROMLO and tover e ll ma

e e et sl i

Designer can deide on the amount of P amount of an chip ROMRAM, 10

ROM, RAMand 10 pts Pats

Expanse, Veratlity For applcatos n which o, pover nd
st 1 il

Cenedl puse Sl e

Tble: .1 Microprocessor verus Mirocontrolle

3.1.1 Block Diagram of the Project

The block diagram of the design is
as shown in Fig 3.1. It consists of power
supply unit, atmega328p controller, limit
switch, GSM, LCD, Energy meter, buzzer
and TRIAC. The brief description about
block diagram is given below.
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Block diagram of proposed system
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3.2 Power Supply

The input to the circuit is applied from the
regulated power supply. The a.c. input i.e.,
230V from the mains supply is step down
by the transformer to 12V and is fed to a
rectifier. The output obtained from the
rectifier is a pulsating d.c voltage. So in
order to get a pure d.c voltage, the output
voltage from the rectifier is fed to a filter to
remove any a.c components present even
after rectification. Now, this voltage is
given to a voltage regulator to obtain a pure
constant dc voltage.

i ; L
Wl SN

- MM M P

‘IDW

&

To AC line

Trans-
former

0= =

Reetifier Filter Regulator | Foyy [ Load

Components of a regulated power supply

Fig: 3.2 Power supply
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Transformer:

Usually, DC voltages are required to operate
various electronic equipment and these
voltages are 5V, 9V or 12V. But these
voltages cannot be obtained directly. Thus
the a.c input available at the mains supply
i.e.,, 230V is to be brought down to the
required voltage level. This is done by a
transformer. Thus, a step down transformer
is employed to decrease the voltage to a
required level.

Rectifier:

The output from the transformer is fed to
the rectifier. It converts A.C. into pulsating
D.C. The rectifier may be a half wave or a
full wave rectifier. In this project, a bridge
rectifier is used because of its merits like
good stability and full wave rectification.

Filter:

Capacitive filter is used in this project. It
removes the ripples from the output of
rectifier and smoothens the D.C. Output
received from this filter is constant until the
mains voltage and load is maintained
constant. However, if either of the two is
varied, D.C. voltage received at this point
changes. Therefore a regulator is applied at
the output stage.

Voltage regulator:

As the name itself implies, it
regulates the input applied to it. A voltage
regulator is an electrical regulator designed
to automatically maintain a constant voltage
level. In this project, power supply of 5V
and 12V are required. In order to obtain
these voltage levels, 7805 and 7812 voltage
regulators are to be used. The first number
78 represents positive supply and the
numbers 05, 12 represent the required
output voltage levels.
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Fig 3: POWER SUPPLY DIAGRAM
Fig: 3.3 Power supply circuit diagram
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3.3.1 Features

1. High Performance, Low Power
Atmel®AVR® 8-Bit Microcontroller
Family

- Advanced RISC Architecture

- 131 Powerful Instructions

- Most Single Clock Cycle Execution
- 32 x 8 General Purpose Working
Registers

- Fully Static Operation

- Up to 20 MIPS Throughput at
20MHz

- On-chip 2-cycle Multiplier

- High  Endurance  Non-volatile
Memory Segments

- 32KBytes of In-System  Self-
Programmable Flash program

2. Memory

- 1KBytes EEPROM

- 2KBytes Internal SRAM

- Write/Erase Cycles: 10,000
Flash/100,000 EEPROM

- Data Retention: 20 years at
85°C/100 years at 25°C(1)

- Optional Boot Code Section with
Independent Lock Bits

« In-System Programming by On-chip
Boot Program

- True Read-While-Write Operation

- Programming Lock for Software
Security

« Atmel® QTouch® Library Support
- Capacitive Touch Buttons, Sliders
and Wheels

- QTouch and QMatrix® Acquisition
- Up to 64 sense channels

3. Atmel-42735B-
ATmega328/P_Datasheet_Complete-
11/2016

- Peripheral Features

- Two 8-bit Timer/Counters with
Separate Prescaler and Compare Mode

- One 16-bit Timer/Counter with
Separate Prescaler, Compare Mode, and
Capture Mode

- Real Time Counter with Separate
Oscillator
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- Six PWM Channels

- 8-channel 10-bit ADC in TQFP and
QFN/MLF package

- Temperature Measurement
- 6-channel 10-bit ADC
Package

- Temperature Measurement
- Two Master/Slave  SPI
Interface

- One Programmable Serial USART

- One Byte-oriented 2-wire Serial
Interface (Philips 12C compatible)

- Programmable Watchdog Timer
with Separate On-chip Oscillator

- One On-chip Analog Comparator

- Interrupt and Wake-up on Pin
Change

- Special Microcontroller Features

- Power-on Reset and Programmable
Brown-out Detection

- Internal Calibrated Oscillator

- External and Internal Interrupt
Sources

- Six Sleep Modes: Idle, ADC Noise
Reduction, Power-save, Power-down,
Standby, and

in PDIP

Serial

>

Extended Standby

1/0 and Packages

23 Programmable 1/0 Lines

28-pin PDIP, 32-lead TQFP, 28-pad
QFN/MLF and 32-pad QFN/MLF

- Operating Voltage:

- 18-55V

- Temperature Range:

- -40°C to 105°C

- Speed Grade:

- 0-4MHz @ 1.8-5.5V

- 0-10MHz @ 2.7 - 5.5V

- 0-20MHz @ 4.5-5.5V

- Power Consumption at 1MHz, 1.8V,
25°C

- Active Mode: 0.2mA

- Power-down Mode: 0.1pA
- Power-save Mode:
(Including 32kHz RTC)

0.75uA
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3.3.2 Description

The Atmel AVR® core combines a rich
instruction set with 32 general purpose
working registers. All the 32 registers are
directly connected to the Arithmetic Logic
Unit (ALU), allowing two independent
registers to be accessed in a single
instruction executed in one clock cycle. The
resulting architecture is more code efficient
while achieving throughputs up to ten times
faster than conventional CISC
microcontrollers.

The ATmega328/P provides the following
features: 32Kbytes of In-System
Programmable Flash with Read-While-
Write capabilities, 1Kbytes EEPROM,
2Kbytes SRAM, 23 general purpose 1/0
lines, 32 general purpose working registers,
Real Time Counter (RTC), three flexible
Timer/Counters with compare modes and
PWM, 1 serial programmable USARTs , 1
byte-oriented 2-wire Serial Interface (12C),
a 6- channel 10-bit ADC (8 channels in
TQFP and QFN/MLF packages) , a
programmable  Watchdog Timer with
internal Oscillator, an SPI serial port, and
six software selectable power saving modes.
The Idle mode stops the CPU while
allowing the SRAM, Timer/Counters, SPI
port, and interrupt system to continue
functioning.

The Power-down mode saves the register
contents but freezes the Oscillator, disabling
all other chip functions until the next
interrupt or hardware reset. In Power-save
mode, the asynchronous timer continues to
run, allowing the user to maintain a timer
base while the rest of the device is sleeping.
The ADC Noise Reduction mode stops the
CPU and all 1/O modules except
asynchronous timer and ADC to minimize
switching noise during ADC conversions. In
Standby mode, the crystal/resonator
oscillator is running while the rest of the
device is sleeping. This allows very fast
start-up combined with low power
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consumption. In Extended Standby mode,
both the main oscillator and the
asynchronous timer continue to run.

Atmel offers the QTouch® library for
embedding capacitive touch buttons, sliders
and wheels functionality into AVR
microcontrollers. The patented charge-
transfer signal acquisition offers robust
sensing and includes fully debounced
reporting of touch keys and includes
Adjacent Key Suppression® (AKS™)
technology for unambiguous detection of
key events. The easy-to-use QTouch Suite
toolchain allows you to explore, develop
and debug your own touch applications.

The device is manufactured using Atmel’s
high  density  non-volatile ~ memory
technology. The On-chip ISP Flash allows
the program memory to be reprogrammed
In-System through an SPI serial interface,
by a conventional nonvolatile memory
programmer, or by an On-chip Boot
program running on the AVR core.

The Boot program can use any interface to
download the application program in the
Application Flash memory. Software in the
Boot Flash section will continue to run
while the Application Flash section is
updated, providing true Read-While-Write
operation. By combining an 8-bit RISC
CPU with In-System Self-Programmable
Flash on a monolithic chip, the Atmel
ATmega328/P is a powerful microcontroller
that provides a highly flexible and cost
effective solution to many embedded
control applications. The ATmega328/P is
supported with a full suite of program and
system development tools including: C
Compilers, Macro Assemblers, Program
Debugger/Simulators, In-Circuit Emulators,
and Evaluation Kits.
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3.3.3 Configuration Summary

Features ATmegad2sP
Pin Count %803

Flash (Bytes) 3K

SRAM (Bytes) X
EEPROM (Bytes) 1K

General Pupose /0 Lines P

SPI

W) {

USART 1

ADC 10-bit 15KSPS
ADC Channels 8

8-bit Tmer/Counters 2

16-bi Timer/Counters 1

Table: 3.2 Arduino Configurations

3.3.4 Block Diagram

FIG: 3.5 ARDUINO BLOCK DIAGRAM
3.3.5 Pin Configurations
Pin-out

FIG: 3.6 PIN DIAGRAM
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Pin Descriptions

VCC

Digital supply voltage.

GND

Ground.

Port B (PB[7:0])

XTALL/XTAL2/TOSC1/TOSC2

Port B is an 8-bit bi-directional 1/0 port
with internal pull-up resistors (selected for
each bit). The Port B output buffers have
symmetrical drive characteristics with both
high sink and source capability. As inputs,
Port B pins that are externally pulled low
will source current if the pull-up resistors
are activated. The Port B pins are tri-stated
when a reset condition becomes active, even
if the clock is not running. Depending on
the clock selection fuse settings, PB6 can be
used as input to the inverting Oscillator
amplifier and input to the internal clock
operating circuit Depending on the clock
selection fuse settings, PB7 can be used as
output from the inverting Oscillator
amplifier. If the Internal Calibrated RC
Oscillator is used as chip clock source,
PB[7:6] is used as TOSC[2:1] input for the
Asynchronous Timer/Counter2 if the AS2
bit in ASSR s set.

Port C (PCI[5:0])

Port C is a 7-bit bi-directional 1/0 port with
internal pull-up resistors (selected for each
bit). The PC[5:0] output buffers have
symmetrical drive characteristics with both
high sink and source capability. As inputs,
Port C pins that are externally pulled low
will source current if the pull-up resistors
are activated. The Port C pins are tri-stated
when a reset condition becomes active, even
if the clock is not running.

PC6/RESET

If the RSTDISBL Fuse is programmed, PC6
is used as an 1/0 pin. Note that the electrical
characteristics of PC6 differ from those of
the other pins of Port C. If the RSTDISBL
Fuse is un programmed, PC6 is used as a
Reset input. A low level on this pin for
longer than the minimum pulse length will
generate a Reset, even if the clock is not

Volume 06 Issue 10
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running. Shorter pulses are not guaranteed
to generate a Reset. The various special
features of Port C are elaborated in the
Alternate Functions of Port C section.

Port D (PD[7:0])

Port D is an 8-bit bi-directional 1/0 port
with internal pull-up resistors (selected for
each bit). The Port D output buffers have
symmetrical drive characteristics with both
high sink and source capability. As inputs,
Port D pins that are externally pulled low
will source current if the pull-up resistors
are activated. The Port D pins are tri-stated
when a reset condition becomes active, even
if the clock is not running.

AVCC

AVCC is the supply voltage pin for the A/D
Converter, PC[3:0], and PE[3:2]. It should
be externally connected to VCC, even if the
ADC is not used. If the ADC is used, it
should be connected to VVCC through a low-
pass filter. Note that PC[6:4] use digital
supply voltage, VCC.

AREF

AREF is the analog reference pin for the
A/D Converter.

ADCJ[7:6] (TQFP and VFQFN Package
Only)

In the TQFP and VFQFN package,
ADCI7:6] serve as analog inputs to the A/D
converter. These pins are powered from the
analog supply and serve as 10-bit ADC
channels.

1/0 Multiplexing

Each pin is by default controlled by the
PORT as a general purpose 1/O and
alternatively it can be assigned to one of the
peripheral functions. The following table
describes the peripheral signals multiplexed
to the PORT 1/0O pins.

FIRMWARE IMPLEMENTATION OF
THE PROJECT DESIGN

4.1 FIRMWARE IMPLEMENTATION

This chapter briefly explains about
the firmware implementation of the project.
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The required software tools are discussed in
section 4.2.

Software Tool Required

Arduino 1.0.6 software tools used to
program microcontroller. The working of
software tool is explained below in detail.

PROGRAMMING
MICROCONTROLLER

A compiler for a high level language
helps to reduce production time. To
program the Arduino UNO microcontroller
the Arduino is used. The programming is
done strictly in the embedded C language.
Arduino is a suite of executable, open
source software development tools for the
microcontrollers hosted on the Windows
platform.

Arduino is a tool for making
computers that can sense and control more
of the physical world than your desktop
computer. It's an open-source physical
computing platform based on a simple
microcontroller board, and a development
environment for writing software for the
board.

One of the difficulties of
programming microcontrollers is the limited
amount of resources the programmer has to
deal with. In personal computers resources
such as RAM and processing speed are
basically limitless when compared to
microcontrollers. In contrast, the code on
microcontrollers should be as low on
resources as possible

4.2. ABOUT ARDUINO COMPILER
4.2.1. GET AN ARDUINO BOARD AND
USB CABLE

You also need a standard USB cable (A
plug to B plug): the kind you would connect
to a USB printer, for example. (For the
Arduino Nano, you'll need an A to Mini-B
cable instead.)

Volume 06 Issue 10
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FIG 4.1: ARDUINO BOARD AND USB
CABLE
4.2.2. CONNECT THE BOARD

The Arduino Uno, Mega,
Duemilanove and Arduino Nano
automatically draw power from either the
USB connection to the computer or an
external power supply. If you're using an
Arduino Diecimila, you'll need to make sure
that the board is configured to draw power
from the USB connection. The power
source is selected with a jumper, a small
piece of plastic that fits onto two of the
three pins between the USB and power
jacks. Check that it's on the two pins closest
to the USB port. Connect the Arduino board
to your computer using the USB cable. The
green power LED (labelled PWR) should go
on.
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\ Select your board

You'll need to select the entry in the Tools >

« N \
TN Boar(_:i menu that corresponds to your
o AL Arduino.
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FIG 4.2 OPENING THE ARDUINO
WINDOW

Open the blink example
Open the LED blink example sketch: File >
Examples > 1.Basics > Bllnk
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FIG4 5! SELECTING AN ARDUINO
UNO

4.2.2.1 WRITING SKETCHES

Software written using Arduino are
called sketches. These sketches are written
in the text editor. Sketches are saved with
the file extension .ino. It has features for
cutting/pasting and for searching/replacing
text. The message area gives feedback while
saving and exporting and also displays
errors. The console displays text output by
the  Arduino  environment including
complete error messages and other
information. The bottom righthand corner of
the window displays the current board and
serial port. The toolbar buttons allow you to
verify and upload programs, create, open,
and save sketches, and open the serial
monitor.

NB: Versions of the IDE prior to 1.0 saved
sketches with the extension .pde. It is
possible to open these files with version 1.0,
you will be prompted to save the sketch
with the .ino extension on save.

FIG 4.4: SOURCE CODE WRITTEN IN
ARDUINO COMPILER
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1. SELECT YOUR SERIAL PORT whichever sketch was most recently
device of the uploaded to the microcontroller. The

Select the serial
Arduino board from the Tools | Serial Port
menu. This is likely to be COM3 or higher
(COM1land COM2 are usually reserved for
hardware serial ports). To find out, you can
disconnect your Arduino board and re-open
the menu; the entry that disappears should
be the Arduino board. Reconnect the board
and select that serial port.

UPLOAD THE PROGRAM

Before uploading your sketch, you
need to select the correct items from
the Tools > Board and Tools > Serial Port
menus. The boards are described below. On

the Mac, the serial port is probably
something like /dev/tty.usbmodem241 On
Windows, it's probably COM1
or COM2 (for a serial board)

or COM4, COM5, COM7, or higher (for a
USB board) - to find out, you look for USB
serial device in the ports section of the
Windows Device Manager. On Linux, it
should  be /dev/ttyUSBO,/dev/ttyUSB1 or
similar.

Once you've selected the correct
serial port and board, press the upload

button in the toolbar or select
the Upload item from the File menu.
Current  Arduino boards will reset

automatically and begin the upload. With
older boards (pre-Diecimila) that lack auto-
reset, you'll need to press the reset button on
the board just before starting the upload. On
most boards, you'll see the RX and
TX LEDs blink as the sketch is uploaded.
The Arduino environment will display a
message when the upload is complete, or
show an error.

When you upload a sketch, you're
using the Arduino bootloader, a small
program that has been loaded on to the
microcontroller on your board. It allows you
to upload code without using any additional
hardware. The bootloader is active for a few
seconds when the board resets; then it starts

bootloader will blink the on-board (pin 13)
LED when it starts (i.e. when the board
resets).

Now, simply click the "Upload"
button in the environment. Wait a few
seconds - you should see the RX and TX
leds on the board flashing. If the upload is
successful, the message "Done uploading.”
will appear in the status bar. (Note: If you
have an Arduino Mini, NG, or other board,
you'll need to physically present the reset
button on the board immediately before
pressing the upload button.)

FIG 4.6: COMPILATION UNDER
PROCESS

A few seconds after the upload finishes, you
should see the pin 13 (L) LED on the board
start to blink (in orange). If it does,
congratulations! You've gotten Arduino up-
and-running.
RESULTS AND DISCUSSIONS

1.2 WORKING PROCEDURE
The Project Smart Meter is an exclusive
project that enables the user to consume the
power in a more efficient way and saves
power to the electricity department.

The user can switch on/off the device by
sending messages to the device. The power
status will be displayed on the LCD. The
bill will be generated for every two months
giving the details of number of units
consumed. If the user did not pay the bill
within the specified time, the system will
shut down automatically. Buzzer will be
turned on if the system shuts down.

In this design, we have taken the duration of
4 minutes to generate the bill. This bill will
be automatically sent to the predefined
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mobile. Thus, accordingly the user has to
clear the due payments within the specified
time....

5.4 ADVANTAGES

1
2.
3.
4
5

S.
1.

Reduce operation cost

Easy to use

Performance is high

Portable & globally usage
Automatic operation

5 DISADVANTAGES

Possibility of failure due to

communication problems.
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